
طراحی یک سرنگ با جزییات کامل

جزییات آموزش
Adobe Illustrator CS5 :برنامه

سطح آموزش: متوسط
زمان مورد نیاز برای تکمیل پروژه: 2 ساعت 

پیش نمایش تصویر نهایی

در آموزش امروز یاد خواهید گرفت چگونه یک سرنگ را با تمام جزییات طراحی کنید. برای طراحی این سرنگ 
از اشکال ساده و نیز تنظیمات پنل Pathfinder در مواقعی که نیاز به برش دادن شکل دارید استفاده می کنیم. 

سپس با استفاده از گرادیانت جزییات شکل را رنگ آمیزی می کنیم. 

مرحله1
کلیدهای Ctrl + N را فشار دهید تا یک سند جدید ایجاد شود. width سند را 600 و height آن را 700 در 

نظر بگیرید سپس روی دکمه Advanced کلیک کنید. گزینه های RGB و )72ppi( Screen را انتخاب کرده 
و مطمئن شوید تیک "Align New Objects to Pixel Grid" زده شده است. سپس روی دکمه OK کلیک 

کنید. 

)Grid (View > Show Grid و سپس )Snap to Grid (View > Snap to Grid را فعال کنید. حالا به 
یک شبکه با واحدهای 1px نیاز دارید. به مسیر Edit > Preferences > Guides > Grid رفته، مقدار 1 را در 

کادر Gridline every و Subdivisions وارد کنید. 

شما می توانید از طریق پنل )Info (Window > Info پیش نمایش زنده سایز و محل قرارگیری اشکال خود 
 Edit > را مشاهده کنید. فراموش نکنید واحد اندازه گیری را به پیکسل تغییر دهید. برای این کار به مسیر

Preferences > Unit > General بروید. همه این گزینه ها به طور قابل ملاحظه ای سرعت کار شما را پایین 
می آورد. 
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مرحله2
 20=G 0=R را انتخاب کرده و شکلی به اندازه صفحه طراحی رسم کنید. آن را با رنگ Rectangle (M( ابزار

B=30 رنگ آمیزی کرده و مطمئن شوید رنگ stroke در حالت None قرار دارد. این، پس زمینه تصویر خواهد 
بود. به پنل Layers رفته و لایه مستطیل را قفل کنید. 
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مرحله3

ابزار )Rectangle (M را انتخاب کرده و یک شکل 55x215 پیکسلی رسم کنید. آن را با رنگ سفد رنگ آمیزی 
کرده و به مسیر Effect > Stylize > Rounded Corners بروید. مقدار radius را به 2px تغییر داده و روی 

دکمه Ok کلیک کنید سپس به مسیر Effect > Warp > Arc Lower بروید. تنظیمات را مطابق شکل زیر 
اعمال نموده و روی دکمه Ok کلیک کنید سپس به مسیر Object > Expand Appearance بروید.
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مرحله4
شکلی که در مرحله قبل طراحی کردید را انتخاب کرده و به پنل Appearance بروید. رنگ فعلی را انتخاب کرده و 
آن را با رنگ B 245=G 245=R=245 جایگزین کنید همچنین opacity آن را به 30 درصد کاهش دهید. مجددا 

در پنل Appearance رنگ دوم را اضافه کنید، برای این کار از دکمه Add New Fill استفاده کنید که یک 
آیکون مربع شکل سفید کوچک در پنل Appearance می باشد. 

رنگ جدید را انتخاب کرده و یک گرادیانت خطی مطابق شکل زیر اضافه کنید، opacity آن را به 30 درصد کاهش 
داده و به مسیر Effect > Path > Offset Path بروید. Offset را به 1- تغییر داده و روی دکمه Ok کلیک 

کنید. عدد سفید رنگ در تصویر گرادیانت نشان دهنده درصد محل قرارگیری و عدد زرد رنگ نشان دهنده درصد 
opacity است. به پنل Appearance بازگردید، مطمئن شوید شکل هنوز در حالت انتخاب قرار دارد سپس یک 

 155=G 155=R و رنگ آن را به )Align to inside( قرار دهید inside 1 اضافه کنید. چیدمان آن را در حالتpt
B=155 تغییر دهید. 

مرحله5
ابزار )Rectangle (M را انتخاب کرده و شکلی به ابعاد 55x2 پیکسل رسم کنید، سپس آن را مطابق تصویر در 

 blending modeآن را به 30 درصد و opacity ،محل خود قرار دهید. شکل را با رنگ سفید رنگ آمیزی کرده
را به Overlay تغییر دهید. این مستطیل را به همراه شکلی که در مرحله قبل ویرایش کردید انتخاب کرده و 

آنها را )group (Ctrl + G کنید. به پنل Layers بروید، روی این فلدر جدید دو بار کلیک کرده و نام آن را به 
"BarrelBack" تغییر دهید. 
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مرحله6
به پنل Layers بروید و فلدری که در مرحله قبل ساختید را انتخاب کنید. شکل بزرگتر را انتخاب کرده ان را کپی 
و سپس Paste in front کنید )Ctrl + C سپس Ctrl + F( و آن را به بیرون فلدر درگ کرده و بالای فلدر قرار 

دهید. فلدر را ببندید، کپی را انتخاب کرده و به پنل Appearance بروید. 

استروک و fill یا رنگ دوم را پاک کنید. رنگ باقی مانده را انتخاب کرده، opacity آن را به 50 درصد کاهش دهید 
و گرادیانت خطی که در تصویر نشان داده شده را اضافه کنید. به یاد داشته باشید که صفر زرد رنگ در گرادیانت 

نشان دهنده درصد opacity و عدد سفید رنگ نماینده درصد قرارگیری ایستگاه های رنگ است. 
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مرحله7
شکلی که در مرحله قبل طراحی کردید را انتخاب کرده و آن را دو بار کپی و Paste in front کنید. کپی بالایی 
را انتخاب کرده و کلید جهت نمای چپ صفحه کلید را یک بار فشار دهید تا شکل 1 پیکسل به سمت چپ حرکت 

کند. هر دو کپی را انتخاب کرده و روی دکمه Minus Front از پنل Pathfinder کلیک کنید. شکل نهایی را با 
رنگ سفید رنگ آمیزی کرده و به opacity آن را به 40 درصد کاهش دهید. 
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مرحله8
شکلی که در مرحله 6 طراحی کردید را انتخاب و آن را دو بار کپی و Paste in front کنید. کپی رویی را انتخاب 
کرده و آن را یک پیکسل به راست حرکت دهید. هر دو کپی را انتخاب کرده و روی دکمه Minus Front از پنل 
Pathfinder کلیک کنید. شکل نهایی را با رنگ سفید رنگ آمیزی کرده و به opacity آن را به 80 درصد کاهش 

دهید. 
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مرحله9
شکلی که در مرحله 6 طراحی کردید را انتخاب و آن را دو بار کپی و Paste in front کنید. کپی رویی را انتخاب 
کرده و آن را 10 پیکسل به راست حرکت دهید. هر دو کپی را انتخاب کرده و روی دکمه Minus Front از پنل 

Pathfinder کلیک کنید. شکل نهایی را با گرادیانت خطی که در شکل مشاده می کنید رنگ آمیزی کرده و به 
opacity آن را به 30 درصد کاهش دهید. 

مرحله10
شکلی که در مرحله 6 طراحی کردید را انتخاب و آن را دو بار کپی و Paste in front کنید. کپی رویی را انتخاب 
کرده و آن را 10 پیکسل به راست حرکت دهید. هر دو کپی را انتخاب کرده و روی دکمه Minus Front از پنل 

Pathfinder کلیک کنید. شکل نهایی را با گرادیانت خطی که در شکل مشاده می کنید رنگ آمیزی کرده و 
opacity آن را به 20 درصد کاهش دهید. 
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مرحله11
 Rectangle( کنید. ابزار Paste in front شکلی که در مرحله 6 طراحی کردید را انتخاب و آن را یک بار کپی و

M) را برداشته و یک مستطیل به ابعاد 30x25 پیکسل رسم کنید، سپس آن را مطابق شکل در محل مورد نظر قرار 
دهید. شکل را با رنگ سفید رنگ آمیزی کرده و opacity آن را به 70 درصد کاهش دهید. 

مستطیل جدید را به همراه کپی که در ابتدای همین مرحله ایجاد کردید انتخاب کرده و روی دکمه Intersect از 
پنل Pathfinder کلیک کنید. حالا شکل نهایی را با اشکالی که در 5 مرحله آخر ایجاد کردید را انتخاب کردهو 

آنها را با هم )group (Ctrl + G کنید. به پنل Layers رفته و نام فلدر جدید را به "BarrelFront" تغییر دهید. 
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مرحله12
 19x8 را انتخاب کرده و مستطیلی به ابعاد Rectangle (M( حالا روی قسمت پایین شکل متمرکز می شویم. ابزار

پیکسل رسم و آن را با رنگ B 245=G 245=R=245 رنگ آمیزی کنید سپس آن را طمابق شکل در محل خود 
قرار دهید. شکل را انتخاب کرده و به مسیر Effect > Stylize > Rounded Corners بروید. مقدار radius را 
به 1px تغییر داده و روی دکمه Ok کلیک کرده و به مسیر Effect > Warp > Arc Lower بروید. اطلاعات را 
مطابق تصویر زیر وارد کرده، روی دکمه OK کلیک کرده و به مسیر Object > Expand Appearance بروید. 

opacity شکل نهایی را به 30 درصد کاهش دهید. فلدری که در مرحله قبل ساختیم را باز کرده، شکل اصلی را 
انتخاب کرده و آن را کپی و Paste in front کنید، سپس کپی را از فلدر خارج کرده و بالای لایه های موجود در 

پنل لایه ها قرار دهید. این کپی را به همراه شکلی که در ابتدای این مرحله طراحی کردید را انتخاب کرده و روی 
دکمه Minus Front از پنل Pathfinder کلیک کنید. در پایان باید به نتیجه ای شبیه تصویر شماره 5 دست 

پیدا کرده باشید. 
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مرحله13
شکلی که در مرحله قبل طراحی کردید را انتخاب کرده و به مسیر Object > Path > Offset Path بروید. 

 Paste کلیک کنید. شکل نهایی را انتخاب کرده و آن را کپی و Ok را به 1- تغییر داده و روی دکمه Offset مقدار
in front کنید. این کپی را انتخاب کرده و آن را 1px به سمت راست حرکت دهید. هر دو شکل طراحی شده در 

این مرحله را انتخاب کرده و روی دکمه Minus Front از پنل Pathfinder کلیک کنید. فلدر اشکال را انتخاب 
کرده و آن را به )compound path (Object > Compound Path > Make تبدیل کنید. حالا شکل را با 

رنگ سفید رنگ آمیزی کرده و opacity آن را به 80 درصد کاهش دهید. 
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مرحله14
 opacity .رفته و یک رنگ دوم بسازید Appearance شکل طراحی شده در مرحله 12 را انتخاب کنید. به پنل

 Effect > Path > آن را به 30 درصد کاهش دهید، یک گرادیانت خطی مطابق تصویر اول اضافه کرده و به مسیر
Offset Path بروید. 

مقدار Offset را به 1- تغییر داده و روی دکمه OK کلیک کنید. سپس یک stroke به مقدار 1pt به شکل 
 align 165 تغییر داده و آن را=B 165=G 165=R 1 عریض کنید، رنگ آن را بهpt اضافه کنید. آن را به اندازه
 Appearance بروید و رنگ سوم را اضافه کنید. آن را از پنل Appearance کنید. مجددا به پنل to inside

انتخاب کرده و به بالا بکشید، مقدار opacity آن را به 50 درصد کاهش دهید و از گرادیانتی که در تصویر دوم می 
بینید استفاده کنید. 
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مرحله15
ابزار )Rectangle (M را انتخاب کرده و یک مربع 15px رسم کنید سپس آن را مطابق تصویر اول در محل خود 

قرار دهید. مطمئن شوید شکل جدید انتخاب شده است، سپس ابزار )Direct Selection (A را انتخاب کنید. 

نقطه پایین سمت چپ را انتخاب کرده و آن را 1 پیکسل به راست حرکت دهید، سپس دکمه پایین سمت راست را 
انتخاب کرده و آن را 1 پیکسل به چپ حرکت دهید. Snap to Grid کار شما را در این مواقع راحت می کند. در 

پایان باید شکلی شبیه تصویر دوم داشته باشید. 
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مرحله16
شکلی که در مرحله 12 طراحی کردید را انتخاب کرده و آن را کپی و Paste in front کنید و آن را به جلو منتقل 

کنید )Shift + Ctrl + ](. این کپی را به همراه شکلی که در مرحله قبل طراحی کردید انتخاب کرده و روی دکمه 
Minus Front از پنل Pathfinder کلیک کنید. در پنل Layers، فلدر اشکال به وجود آمده را انتخاب کرده و 

آن را )ungroup (Shift + Ctrl + G و سپس شکل بالایی را پاک کنید. 

مرحله17
شکلی که در مرحله قبل طراحی کردید را انتخاب کرده و به مسیر Object > Path > Offset Path بروید. 
 Paste in کلیک کنید. شکل نهایی را انتخاب کرده و آن را کپی وOk را به 1- تغییر داده و روی دکمه Offset

front کنید. این کپی را انتخاب و آن را 1 پیکسل به راست حرکت دهید. هر دو شکل طراحی شده در این مرحله 
را انتخاب کرده و روی دکمه Minus Front از پنل Pathfinder کلیک کنید. فلدر حاصل شده از اشکال را 

انتخاب کرده و آن را به )compound path (Object > Compound Path > Make تبدیل کنید. حالا 
شکل را با رنگ سفید رنگ آمیزی کرده و opacity آن را به 80 درصد کاهش دهید. 
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مرحله18
شکل طراحی شده در مرحله 16 را انتخاب کرده و به پنل Appearance بروید. یک رنگ دوم اضافه کرده، 

 Effect > آن را به 30 درصد کاهش داده، یک گرادیانت خطی مطابق شکل زیر اضافه کنید و به مسیر opacity
 stroke کلیک کنید. در ادامه یک OK را به 1- تغییر داده و روی دکمه Offset .بروید Path > Offset Path

به مقدار 1pt به شکل اضافه کنید. آن را به اندازه 1pt عریض رکده، رنگ آن را به B 165=G 165=R=165 تغییر 
داده و آن را align to inside کنید. مجددا به پنل Appearance بروید و رنگ سوم را اضافه کنید. آن را از پنل 
Appearance انتخاب کرده، به بالا بکشید و opacity آن را به 50 درصد کاهش دهید، سپس از گرادیانت خطی 

که در تصویر نشان داده شده استفاده کنید. 

مرحله19
همه اشکال طراحی شده در 7 مرحله آخر را انتخاب کرده و آنها را )group (Ctrl + G کنید. 
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مرحله20
ابزار )Rectangle (M را انتخاب کرده و مستطیلی به ابعاد 51x219px رسم کنید، سپس آن را با رنگ دلخواه 

رنگ آمیزی کنید. مجددا یک مستطیل به ابعاد 25x61px رسم کرده و آن را مطابق تصویر دوم در محل خود قرار 
دهید. سپس یک مستطیل 51x21px رسم کرده و آن را مطابق تصویر سوم در محل مورد نظر قرار دهید. روی 
مستطیل سوم متمرکز می شویم. ابزار )Selection (A را انتخاب کرده، نقاط بالایی را انتخاب کرده و به مسیر 

Object > Path > Average بروید. تیک Both را بزنید و روی دکمه OK کلیک کنید. مستطیل شما باید به 
مثلث تبدیل شده باشد. 
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مرحله21
همه اشکال طراحی شده در مرحله قبل را انتخاب کرده و روی دکمه Unite از پنل Pathfinder کلیک کنید. 

سپس به دستور Round Any Corner نیاز دارید. شما می توانید این دستور را در پوشه دانلود پیدا کنید. آن را 
روی هارد سیستم خود ذخیره کرده، سپس به Illustrator بازگردید و ابزار )Direct Selection (A را انتخاب 

کنید. 

4 نقطه ای را که در تصویر زیر مشخص شده را انتخاب کرده و به مسیر File > Scripts > Other Script بروید. 
Round Any Corner Script را باز کرده و Radius را به 2px تغییر دهید سپس روی دکمه OK کلیک 

 File > Scripts > Other کنید. حالا دو نقطه مشخص شده با رنگ آبی در تصویر را انتخاب کرده و به مسیر
Script بروید. 

مجددا، Round Any Corner Script را باز کنید، Radius را به 4px تغییر داده و روی دکمه OK کلیک 
 Paste in Back کنید. در پایان اشکال شما باید شبیه تصویر سوم شده باشند. آن را انتخاب کرده و آن را کپی و

 "Help" رفته، روی این کپی دو بار کلیک کنید و نام آن را به Layers به پنل .)Ctrl + B سپس Ctrl + C(کنید
تغییر دهید. آن را به پایین پنل لایه ها بکشید، بعدا به آن نیاز پیدا خواهیم کرد. 

مرحله22
ابزار )Rectangle (M را انتخاب کرده، مستطیلی به ابعاد 5x280px رسم کنید و آن را مطابق تصویر در جای 
 Paste in 177 رنگ آمیزی کرده سپس آن را کپی و=B 177=G 177=R خود قرار دهید. مستطیل را با رنگ

front کنید )Ctrl + C سپس Ctrl + F(. این کپی را به همراه کلی که در مرحله قبل طراحی کردید انتخاب کرده 
  ungroup کلیک کنید. به پنل لایه رفته و فلدر ایجاد شده را Pathfinder از پنل Minus Front و روی دکمه

Shift + Control + G)( کنید. 
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مرحله23
 Ctrl + F > سپس Ctrl + C( کنید Paste in front 5 را انتخاب کرده و آن را دو بار کپی وx280px مستطیل
Ctrl + F(. کپی بالایی را انتخاب کرده و آن را 1 پیکسل به راست حرکت دهید. هر دو کپی را انتخاب کرده و روی 
دکمه Minus Front از پنل Pathfinder کلیک کنید. شکل نهایی را با رنگ B 225=G 225=R=225 رنگ 

آمیزی کنید. 
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مرحله24
 Ctrl + F > سپس Ctrl + C( کنید Paste in front 5 را انتخاب کرده و آن را دو بار کپی وx280px مستطیل

Ctrl + F(. کپی بالایی را انتخاب کرده و آن را 1 پیکسل به چپ حرکت دهید. هر دو کپی را انتخاب کرده و روی 
دکمه Minus Front از پنل Pathfinder کلیک کنید. شکل نهایی را با رنگ B 151=G 151=R=150 رنگ 

آمیزی کنید.
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مرحه25
شکل سمت راست را که در مرحله 22 طراحی کردید را انتخاب کرده و رنگ یک دست آن را با گرادیانتی که در 

تصویر مشاهده می کنید جایگزین نمایید. 
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مرحله26
 Ctrl +( کنید Paste in front  شکلی که در مرحله قبل ویرایش کردید را انتخاب کرده و دو بار آن را کپی و

C سپس Ctrl + F > Ctrl + F(. کپی بالایی را انتخاب کرده و آن را 1 پیکسل به چپ حرکت دهید. هر دو کپی 
 215=R کلیک کنید. شکل نهایی را با رنگ Pathfinder از پنل Minus Front را انتخاب کرده و روی دکمه

B 215=G=215 رنگ آمیزی کنید. 
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مرحله27
شکل که در مرحله 25 ویرایش کردید را انتخاب و آن را دو بار کپی و  Paste in front کنید )Ctrl + C سپس 

Ctrl + F > Ctrl + F(. کپی پایینی یا زیرین را انتخاب کرده و آن را به مقدار  1 پیکسل به راست حرکت دهید. 
هر دو کپی را انتخاب کرده و روی دکمه Minus Front از پنل Pathfinder کلیک کنید. شکل نهایی را با رنگ 

B 138=G 138=R=137 رنگ آمیزی کنید. 
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مرحله28
شکل سمت چپ را که در مرحله 22 طراحی کردید انتخاب کرده و رنگ آن را با گرادیانت خطی که در تصویر 

مشاهده می کنید جایگزین نمایید. 
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مرحله29
 Ctrl + C( کنید Paste in front  شکل که در مرحله قبل ویرایش کردید را انتخاب و آن را دو بار کپی و

سپس Ctrl + F > Ctrl + F(. کپی بالایی را انتخاب کرده و آن را 1 پیکسل به راست حرکت دهید. هر دو کپی 
 245=R کلیک کنید. شکل نهایی را با رنگ Pathfinder از پنل Minus Front را انتخاب کرده و روی دکمه

B 245=G=245 رنگ آمیزی کنید. 
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مرحله30
شکل که در مرحله قبل ویرایش کردید را انتخاب و آن را دو بار کپی و  Paste in front کنید )Ctrl + C سپس 
Ctrl + F > Ctrl + F(. کپی بالایی را انتخاب کرده و آن را 1 پیکسل به چپ حرکت دهید. هر دو کپی را انتخاب 

 138=G 138=R کلیک کنید. شکل نهایی را با رنگ Pathfinder از پنل Minus Front کرده و روی دکمه
B=137 رنگ آمیزی کنید. 
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مرحله31
شکل که در مرحله 25 ویرایش کردید را انتخاب کرده، به پنل Appearance بروید و رنگ دوم را اضافه کنید 

سپس گرادیانت خطی را که در تصویر مشاهده م یکنید استفاده کنید. opacity آن را به 10 درصد تغییر داده و به 
مسیر Effect > Path > Offset Path بروید. مقدار Offset را به 1- تغییر داده و روی دکمه OK کلیک کنید. 
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مرحله32
شکل که در مرحله 28 ویرایش کردید را انتخاب کرده، به پنل Appearance بروید و رنگ دوم را اضافه کنید 

 Effect > Path > Offset Path سپس گرادیانت خطی را که در تصویر مشاهده می کنید استفاده کنید. به مسیر
بروید. مقدار Offset را به 1- تغییر داده و روی دکمه OK کلیک کنید. 
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مرحله33
 Paste in را که در مرحله 21 طراحی کردید را انتخاب کرده و آن را کپی و "Help" بروید، شکل Layers به پنل
front کنید )Ctrl + C سپس Ctrl + F(. ابزار )Rectangle (M را انتخاب کرده، یک مستطیل 51x10px رسم 

نموده و آن را مطابق تصویر در محل خود قرار دهید. 
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مرحله34
شکلی که در مرحله قبل طراحی کردید را انتخاب کرده و آن را با گرادیانت خطی که در شکل نشان داده شده رنگ 

 35=R 51 رسم نموده و آن را با رنگx2px را انتخاب کرده، یک مستطیل )Rectangle (M آمیزی کنید. ابزار
B 35=G=35 رنگ آمیزی کنید سپس آن را مطابق شکل در محل مورد نظر قرار دهید. 
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مرحله35
همه اشکالی را که در 15 مرحله آخر طراحی کردید را انتخاب کرده و آنها را )group (Ctrl + G کنید. به 

پنل Layers رفته و نام این فلدر را به "Plunger" تغییر دهید، سپس آن را بین فلدرهای "BarrelBack" و 
"BarrelFront" قرار دهید. در پایان باید به نتیجه ای شبیه تصویر دوم دست پیدا کرده باشید. 

مرحله36
 Ctrl + سپس Ctrl + C( را انتخاب کرده و یک کپی جدید از آن بسازید "Help" بروید، شکل Layers به پنل
F(. ابزار )Rectangle (M را انتخاب کرده، یک مستطیل 55x5px رسم نموده و آن را با گرادیانتی که در تصویر 

 Effect > مشاهده می کنید رنگ آمیزی کنید. مطمئن شوید شکل جدید انتخاب شده است، سپس به مسیر
Stylize > Rounded Corners بروید. radius را به 2px تغییر داده و روی دکمه OK کلیک کنید و به مسیر 

Effect > Warp > Bulge بروید. مشخصات لازم را طبق تصویر زیر وارد کرده و روی دکمه OK کلیک کنید 
سپس به مسیر Object > Expand Appearance بروید. 
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مرحله37
شکلی را که در مرحله قبل طراحی کردید انتخاب کرده و به مسیر Object > Path > Offset Path بروید. 

مقدار Offset را به 1- تغییر داده و روی دکمه OK کلیک کنید. شکل نهایی را انتخاب کرده و آن را کپی و 
Paste in front کنید. این کپی را انتخاب کرده و آن را به مقدار 1px به راست و پایین حرکت دهید. حالا هر 

 225=R کلیک کنید. شکل نهایی را با رنگ Pathfinder از پنل Minus Front دو کپی را انتخاب کرده و روی
B 225=G=225 رنگ آمیزی کنید. 
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مرحله38
)Snap to Grid (View > Snap to Grid را غیر فعال کنید. شکلی که در مرحله 36 طراحی کردید را انتخاب 

کرده و یک stroke به مقدار 1pt اضافه کنید، سپس چیدمان آن را در حالت inside قرار دهید و رنگ آن را به 
B 177=G 177=R=177 تغییر دهید. مطمئن شوید شکل هنوز در حالت انتخاب قرار دارد سپس آن را کپی و 

سپس Paste in Back کنید)Ctrl + C سپس Ctrl + B(. آن را انتخاب کرده و به مقدار 2px به پایین حرکت 
دهید. 
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مرحله39
مجددا )Snap to Grid (View > Snap to Grid را فعال کنید. به پنل Layers بروید، شکل "Help" را 

انتخاب کرده و آن را کپی و Paste in front کنید. با ابزار )Rectangle (M مستطیلی به ابعاد 85x5px رسم 
کرده و آن را با گرادیانت خطی که در تصویر مشاهده می کنید رنگ آمیزی نماییدو 

 Effect > Stylize > Rounded Corners مطمئن شوید این شکل جدید انتخاب شده است سپس به مسیر
 Effect > Warp > Bulge کلیک کنید سپس به مسیر OK 2 تغییر داده و روی دکمهpx را به radius .بروید

 Object > کلیک کنید پس از آن به مسیر OK بروید. مشخصات لازم را طبق تصویر زیر اعمال کرده و روی دکمه
Expand Appearance بروید. 
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مرحله40
شکلی که در مرحله قبل طراحی کردید را انتخاب کرده و به مسیر Object > Path > Offset Path بروید. 

 Paste in front  کلیک کنید. شکل نهایی را انتخاب و آن را کپی و ok را به 1- تغییر داده و روی Offset مقدار
کنید. کپی را انتخاب کرده و آن را 1px به پایین و سمت راست حرکت دهید. هر دو کپی را انتخاب کرده و روی 

 225=B 225=G 225=R کلیک کنید. شکل به دست آمده را با رنگ Pathfinder از پنل Minus Front دکمه
رنگ آمیزی کنید. 
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مرحله41
)Snap to Grid (View > Snap to Grid را غیر فعال کنید. شکلی که در مرحله 39 طراحی کردید را انتخاب 

کرده و یک stroke به مقدار 1pt اضافه کنید، سپس چیدمان آن را در حالت inside قرار دهید و رنگ آن را 
به B 177=G 177=R=177 تغییر دهید. مطمئن شوید شکل هنوز در حالت انتخاب قرار دارد سپس آن را کپی 

و سپس Paste in Back کنید)Ctrl + C سپس Ctrl + B(. آن را انتخاب کرده و به مقدار 2px به بالا حرکت 
 Pathfinder از پنل Intersect انتخاب کرده و روی دکمه "Help" دهید. سپس این کپی را به همراه کپی

کلیک کنید. شکل به دست آمده را انتخاب کرده و رنگ stroke را پاک کنید، آن را با رنگ سیاه رنگ آمیزی کرده 
و opacity آن را به 10 درصد کاهش دهید. 
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مرحله42
 Ctrl +(کنید Paste in Back شکلی که در مرحله 39 طراحی کردید را انتخاب کرده سپس آن را کپی و سپس
C سپس Ctrl + B( و آن را 2px به پایین حرکت دهید. این کپی را به همراه شکل اصلی "Help" انتخاب کرده 

 stroke کلیک کنید. شکل به دست آمده را انتخاب کرده و رنگ Pathfinder از پنل Intersect  و روی دکمه
 Layers آن را به 10 درصد کاهش دهید. به پنل opacity را پاک کنید، آن را با رنگ سیاه رنگ آمیزی کرده و

بروید، این شکل را به همراه شکلی که در مرحله قبل طراحی کردید انتخاب کنید و آنها را زیر شکلی که در مرحله 
39 طراحی کردید قرار دهید. 
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مرحله43
همه اشکالی را که در 7 مرحله آخر طراحی کردید انتخاب و آنها را )group (Ctrl + G کنید و فلدر جدید را به 

 .)[ + Shift + Command( جلو منتقل کنید
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مرحله44
مجددا )Snap to Grid (View > Snap to Grid را فعال کنید. روی قسمت پایین اشکال موجود متمرکز 

می شویم. ابزار )Rectangle (M را انتخاب کرده، مستطیلی به ابعاد 17x3px رسم کرده و آن را مطابق شکل در 
محل خود قرار دهید. مستطیل را یک گرادیانت خطی مطابق آنچه در تصویر می بینید رنگ آمیزی کرده و به مسیر 

 OK 1 تغییر داده و روی دکمهpx را به radius بروید. مقدار Effect > Stylize > Rounded Corners
کلیک کنید سپس به مسیر Object > Expand Appearance بروید. 

مرحله45
 Ctrl + C( کنید Paste in front شکلی که در مرحله قبل طراحی کردید را انتخاب کرده و آن را دو بار کپی و

سپس Ctrl + F > Ctrl + F(. کپی بالایی را انتخاب کرده و آن را 1px به سمت راست حرکت دهید. هر دو کپی 
 166=R کلیک کنید. شکل نهایی را با رنگ Pathfinder از پنل Minus Front را انتخاب کرده و روی دکمه

B 224=G=221 رنگ آمیزی کنید. 
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مرحله46
 Ctrl + C( کنید Paste in front شکلی که در مرحله 44 طراحی کردید را انتخاب کرده و آن را دو بار کپی و
سپس Ctrl + F > Ctrl + F(. کپی بالایی را انتخاب کرده و آن را 1px به سمت بالا حرکت دهید. هر دو کپی 
 15=R کلیک کنید. شکل نهایی را با رنگ Pathfinder از پنل Minus Front را انتخاب کرده و روی دکمه

B 135=G=125 رنگ آمیزی کنید. 

مرحله47
ابزار )Rectangle (M را انتخاب کرده، مستطیلی به ابعاد 15x38px رسم کرده، آن را با رنگ دلخواه رنگ آمیزی 
کرده و مطابق شکل در محل خود قرار دهید سپس به مسیر Object > Path > Add Anchor Points بروید. 

مطمئن شوید شکل جدید انتخاب شده است سپس ابزار Direct (Selection (A را انتخاب کنید. 

دکمه پایین سمت چپ را انتخاب کرده و آن را به اندازه 4px به سمت راست بکشید، سپس دکمه پایین سمت 
راست را انتخاب کرده و آن را 4px به سمت چپ بکشید. نقطه وسط سمت چپ را انتخاب کرده و آن را 7px به 
پایین حرکت دهید سپس نقطه وسط سمت راست را انتخاب کرده و آن را 7px به پایین حرکت دهید. در پایان 

باید به نتیجه ای شبیه تصویر زیر دست پیدا کرده باشید. 
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مرحله48
 167=G 0=R 3 رسم کرده، آن را با رنگx38px را انتخاب کرده، مستطیلی به ابعاد Rectangle (M( ابزار

 Paste 157 رنگ آمیزی کرده و مطابق تصویر در محل خود قرار دهید. مستطیل را انتخاب کرده و آن را کپی و=B
 Minus Front کنید. این کپی را به همراه شکل که در مرحله قبل طراحی کردید انتخاب کرده و روی in front

از پنل Pathfinder کلیک کنید. به پنل Layers رفته، فلدر شکل گرفته را نتخاب و آن را از حالت group خارج 
 .)Shift + Control + G( کنید

مرحله49
مستطیل 3x38px را انتخاب کرده و دو کپی از آن بگیرید )Ctrl + C > Ctrl + F > Ctrl + F(. کپی بالایی را 

 Minus 1 به سمت راست حرکت دهید. هر دو کپی را انتخاب کرده و روی دکمهpx انتخاب کرده و آن را به اندازه
Front از پنل Pathfinder کلیک کنید. شکل نهایی را با رنگ B 187=G 58=R=179 رنگ آمیزی کنید. 
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مرحله50
مستطیل 3x38px را انتخاب کرده و دو کپی از آن بگیرید )Ctrl + C > Ctrl + F > Ctrl + F(. کپی بالایی را 
 Minus 1 به سمت چپ حرکت دهید. هر دو کپی را انتخاب کرده و روی دکمهpx انتخاب کرده و آن را به اندازه

Front از پنل Pathfinder کلیک کنید. شکل نهایی را با رنگ B 135=G 15=R=125 رنگ آمیزی کنید.  

مرحله51
شکل سمت راست را که در مرحله 48 طراحی کردید انتخاب کرده و رنگ یک دست آن را با گرادیانت خطی که در 

تصویر می بینید جایگزین کنید. 
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مرحله52
 Ctrl + C > Ctrl + F > Ctrl( شکلی که در مرحله قبل ویرایش کردیم را انتخاب کرده و دو کپی از آن بگیرید
F +(. کپی بالایی را انتخاب کرده و آن را به اندازه 1px به سمت چپ حرکت دهید. هر دو کپی را انتخاب کرده و 

روی دکمه Minus Front از پنل Pathfinder کلیک کنید. شکل نهایی را با رنگ B 106=G 12=R=95 رنگ 
آمیزی کنید.  

مرحله53
شکلی که در مرحله 51 ویرایش کردید را انتخاب کرده، به پنل Appearance بروید، یک رنگ دوم اضافه کرده 
 Effect > Path > Offset و از گرادیانتی که در تصویر می بینید استفاده کنید. آن را انتخاب کرده و به مسیر

Path بروید. مقدار Offset را به 1- تغییر داده و روی دکمه OK کلیک کنید. 
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مرحله54
شکل سمت چپ را که در مرحله 48 طراحی کردید انتخاب کرده و رنگ یک دست آن را با گرادیانت خطی که در 

تصویر می بینید جایگزین کنید. 

مرحله55
 Ctrl + C > Ctrl + F > Ctrl( شکلی که در مرحله قبل ویرایش کردیم را انتخاب کرده و دو کپی از آن بگیرید
F +(. کپی بالایی را انتخاب کرده و آن را به اندازه 1px به سمت راست حرکت دهید. هر دو کپی را انتخاب کرده 
 179=B 187=G 58=R کلیک کنید. شکل نهایی را با رنگ Pathfinder از پنل Minus Front و روی دکمه

رنگ آمیزی کنید.  
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مرحله56
شکلی که در مرحله 54 طراحی کردید را انتخاب کرده، سپس با استفاده از گرادیانتی که در شکل می بینید یک 

رنگ دوم اضافه کنید. آن را انتخاب کرده و به مسیر Effect > Path > Offset Path بروید. مقدار Offset را به 
1- تغییر داده و روی دکمه OK کلیک کنید. 
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مرحله57
 226=G 241=R 7 رسم کرده، آن را با رنگx5px را انتخاب کرده، مستطیلی به ابعاد Rectangle (M( ابزار

B=141 رنگ آمیزی کرده و مطابق تصویر در محل خود قرار دهید. مستطیل را انتخاب کرده و به سراغ ابزار  
)Direct Selection (A بروید. نقطه پایین سمت چپ را انتخاب کرده و آن را 1 پیکسل به راست حرکت دهید 

سپس نقطه پایین سمت راست را انتخاب کرده و آن را 1 پیکسل به سمت چپ بکید. 

 Effect در پایان باید شکلی شبیه ذوزنقه داشته باشید. مطمئن شوید شکل هنوز انتخاب شده است سپس به مسیر
Stylize > Rounded Corners < بروید. مقدار radius را به 1px تغییر داده و روی دکمه ok کلیک کنید 

سپس به مسیر Object > Expand Appearance بروید. شکل نهایی را انتخاب کرده و آن را زیر اشکالی که در 
10 مرحله آخر طراحی کردید قرار دهید )در پنل لایه ها(. 

مرحله58
ابزار )Rectangle (M را انتخاب کرده، مستطیلی به ابعاد 3x89px رسم کرده، آن را با گرادیانت خطی که در 

تصویر مشاهده می کنید رنگ آمیزی کنید. مستطیل را انتخاب کرده و ابزار  )Direct Selection (A را انتخاب 
کنید، نقطه پایین سمت راست را انتخاب کرده و آن را 5 پیکسل به بالا حرکت دهید. 
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مرحله59
همه اشکالی که تا اینجا طراحی کرده اید را انتخاب کرده و آنها را )group (Ctrl + G کنید سپس به مسیر 

Object > Transform > Rotate بروید. مقدار 45- را وارد کرده و روی دکمه OK کلیک کنید. 
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مرحله60
فلدری که در مرحله قبل ساختید را انتخاب کرده و آن را کپی و Paste in front کنید. این کپی را انتخاب کرده 

و روی دکمه Unite از پنل Pathfinder کلیک کنید. شکل نهایی را با رنگ B 224=G 166=R=221 رنگ 
آمیزی کرده و blending mode آن را به Color Burn تغییر دهید. 

مرحله61
شکلی که در مرحله قبل طراحی کردید را انتخاب کرده و آن را کپی و Paste in front کنید. کپی را انتخاب 

کرده و blending mode آن را به Normal تغییر دهید سپس آن را با رنگ B 16=G 0=R=23 رنگ آمیزی 
کنید. به پنل Layers رفته و آن را زیر فلدری که در مرحله 59 ساختید قرار دهید. سپس آن را به اندازه 15 

پیکسل به پایین و 10 پیکسل به راست حرکت دهید. 

نتیجه
کار ما به پایان رسید. در زیر نتیجه نهایی آموزش امروز را مشاهده می کنید. 
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مشاهده آموزش های دیگر سایت

www.persianGFX.com    منبع پرشین جی اف ایکس        

http://persiangfx.com/fa/tutorials/illustrator/professional/


Adobe Master Collection CS6 نام کامل ترین مجموعه نرم افزاری شرکت Adobe می باشد که با دارا 
بودن  تمامی نرم افزار های حرفه ای این کمپانی بزرگ در زمینه های طراحی گرافیکی، طراحی وب، میکس و مونتاژ 
فیلم کلیه نیاز های گرافیست ها و هنرمندان را برطرف می کند. این بسته نرم افزاری این امکان را برای شما فراهم 
می آورد تا بتوانید کارهای جذابی را طراحی کرده ، آن را با عناصر تاثیرگذار همراه نموده و در هرجایی که بخواهید 

با بهترین کیفیت ممکن ارائه نمایید.

برخی از ویژگی های مهم این مجموعه:
- مجموعه نرم افزار هایی در جهت ایجاد یک تعامل سازگار و پویا میان طراحان و برنامه نویسان

- ابزاری جهت ارتقاء کلیه پروژهای طراحی، گرافیک، مالتی مدیا، وب و ...
- مدیریت نصب کارا و کامل

- پشتیبانی کامل از ویندوز 7
- و ...

نرم افزار های این بسته عبارتند از:
Extended Photoshop® CS6 -

Illustrator® CS6 -
InDesign® CS6 -

Acrobat® X Pro -
Flash® Professional CS6 -

Premium Edition 4.6 ®Flash Builder -
Dreamweaver® CS6 -

Fireworks® CS6 -
Adobe Premiere® Pro CS6 -

After Effects® CS6 -
Adobe Audition® CS6 -

SpeedGrade™ CS6 -
Prelude™ CS6 -
Encore® CS6 -

Bridge CS6 -
Media Encoder CS6 -

توضیحات بیشتر....

http://persiangfx.com/fa/other/products/adobe-reative-suite-6-master-ollection/
http://persiangfx.com/fa/other/products/adobe-reative-suite-6-master-ollection/


این پکیج شامل تمامی مطالب و موضوعاتی است که در طول سه سال گذشته بر روی سایت گذاشته شده و پس 
از جمع آوری و دسته بندی حرفه ای هم اکنون در اختیار دوست داران و علاقه مندان گرافیک و گرافیست ها قرار 

گرفته است که در ادامه به اختصار محتویات پکیج های فوق را می توانید مشاهده نمایید و اساسا این مجموعه 
شامل موارد فوق می باشد:

 
- بیش از 300 آموزش حرفه ای و مقدماتی نرم افزار فتوشاپ با فرمت پی دی اف به همراه تصاویر و فایل های 

ضمیمه
- بیش از 190 آموزش حرفه ای و مقدماتی نرم افزار ایلوستریتور با فرمت پی دی اف به همراه تصاویر و فایل های 

ضمیمه
- دوره کامل آموزش مقدماتی نرم افزار ایندیزاین بهمراه آموزش های دوره پیشرفته

- دوره کامل آموزش مقدماتی نرم افزار فلش به همراه آموزش های متفرقه
- بیش از 200 مقاله کاربردی با موضوعات مختلف و کاربردی گرافیک با فرمت پی دی اف

- ابزار طراحی شامل لوگو، آیکون، تصاویر وکتور، اسلیمی، کلیپ آرت و...
- تصاویر و آثار هنری هنرمندان و عکاسان جهت گرفتن ایده و افزایش مهارت های طراحی

- دسته بندی حرفه ای مطالب و ابزار کاربردی مطابق با دسته بندی سایت
- بسته بندی زیبا و شکیل با بالاترین کیفیت ممکن

توضیحات بیشتر....

مشاهده سایر محصولات گرافیکی

http://persiangfx.com/fa/other/monthly/graphic-and-design-tools-monthly-archive/
http://persiangfx.com/fa/other/monthly/graphic-and-design-tools-monthly-archive/
http://persiangfx.com/fa/other/products/

